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1. EEBE GameFace Messenger

1.1 &N

F FH {8 FH #EfiE GameFace Messenger » {5 1] LA HAth i | GameFace Mes-
senger FIBTFGEIT RN SO ~ HRELZGOEA © ot > AL Hrr L
PRULITSR FIIRF 17 B Bh A LA Rk B L TR e -

1.2 FAMBILLEE®L

1.2.1 H{TERE GameFace Messenger
AR RHR N YD BEACE I T 2R GameFace Messenger
ERESAA TR Bl 8 o EE R IEHE R R A 2R B

% GameFace £ -
geiEthnr Ll

BEEIE S LAY GameFace EVT: 8 1720 GameFace Messenger °

ameface

1.2.2 EHA—EFIRSE
HIEMAH —1H GameFace Messenger 1&5% » HIFE{KIR N 9120 BR 2 I3 T —HH#T

5%
‘ TEETHNIRSRAVGIMMAT » FAHEREPIE RN ERRE SR E MR

AR IRHR N A28 BEACE i — AR R
1. 1 GameFace Messenger -2 H 1 » B3 File > Go To Support Home °

FILES CONTACT TOOLS

Amemmmy  Tammm
', e et —

Go To » Support Home

Click here to sign in
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2. TELLNAIHE E FP 252 Register New Account 3 o

GAMEFACE MESSENGER

[ MEMBERS SIBN IN

LIVE VIDEO CONFERENCING

Email: ] AND INSTANT MESSENGER
password: | NN

s

SIGN IN

Register New Account
Forgot Your Password?

03-2005 ByteSwarm, All Rights Reserved.

3. AR E R A TE B ERAL b o A ST R A BE T B L A
REGISTER NOW #4k -

& POWERED BY

£ ™
byteSWARM"™

Il Register New Account

Email

Password
Confirm Password
First Name

Last Name
Gender

Phone

Address1

Address2

REGISTER NOW

©2003-2005 ByteSwarm, All Rights Reserved.

4. BT GRIRIRER RO E TR E DU GE T ©
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1.2.3 & AZl GameFace Messenger
A SN 91D B A FI| GameFace Messenger

1. #1BEE I GameFace Messenger 3% & 5841 | Internet {218 H Bt 1%
A » HIZEE5E File > Sign In

TEFEHEEE Click here to sign in * BHESTHEZ LT R He L o

3et & GameFace ID

Ernail: FE@asus, cam.bw

Remember my
Sign me in auko

2. HIERIE NG RUA G E G NG o IS0 3B R 5 35HE A 4K i
AEHIEFE b (Bmail) HZHE (Password) » &3 50E OK °
3. HIEREEEAERAFAEN D 0B HERIRREEE
(Remember my ID & Password) 32 /r [lIATEZHAE
4, FEHETEHER T Internet IR Al H )8 A £ GameFace Messenger * HIFE %)
EEHBEZE A (Sign me in automatically ) /¢ (Il %1Z5E

‘ AR ANKRERE - BRETEETTH 3 BER 4 RS
UZEMEABRIEINE -
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1.2.4 & GameFace Messenger
AR IRIE T 125 B8 H GameFace Messenger

{hsl=] JEEEE

#fiH1 GameFace Messenger )4 ZH I EEE File > Sign Out °
1.2.5 BFEFEAEMA GameFace Messenger B
AR N 9120 BEACHGE HoAth 8 FH I A GameFace Messenger 75

1. HALE A& B rh DAY St AR i e (A R O B 2 R B T
-

2. TEBkH = E 1252 Invite GameFace Conference /5 °

Send an instant message
Zend a file or a photo

Zend Emadl (test@asns com tw)
View Mesage History
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3. i GameFace Messenger H % FJ i S( 4% 8 i1 { & [A]IFF 22 Bl GameFace 15
ek o MEHIEETIY T &R R EE o

ASUS GameFace Cnnlerenl:e

.10.111.55 10.10.111.54

4, EIEBEHITEBEREEIEH GameFace Messenger * H'J?ﬁ?‘ NG
HEARER (0SD) » BURTEH#EIT 2R ELEENRT - 2);# oSD
Enable Gameface SEJEAYEIZEHE -
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1.2.6 BFRTREB

R RIRT 510 B B A R 4

£ GameFace Messenger 125 1 » 55%43E Tools > Change Display Name ©
ARELL N AR T TR -

127 BEIRE

AR RBRT 91125 B 458 5 1 E AR {5 ARG

£ GameFace Messenger [+ 3E H 1 » 525 Tools > Change My Status * 4%
S R T S T 7 B SRR T P B AR RE o

Always On Top

Change Display Name 1
Online

Be Right Back

Lway
Lunch
Phone
A ppear Cffline
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1.3 SEEA
1.3.1 BI—{I#FHERA
S BT G125 B AR A — (TS A

£ GameFace Messenger H - Z Bt » B13% Contact > Add a Contact © lfi ff i L
N EEAHETHETIRIE o

FILES

View Contact
Sort Contacts bor

Create a New Gooup

1.3.2 MIBF—LDERA
FA IR N 910 B AR HBR B A A8 A -

£ GameFace Messenger 425 1 » Bi3% Contact > Delete a Contact ° illi{{
BRLLS SIS T T IR -

ERBLFEATMH 13



1.3.3 SEBERABERTLI
AR HRIR T 51120 B e A FARER 5

E GameFace Messenger £ #H 1 » 2% Contact > View Contact © #3515 1]
LLi#4# By Display Name 502 By Email RifEfR 5 /72 o

FILES  CONTACT _ TOOLS
Add a Contact
Delete a Contact
At
Bort Contacts bor

Create a Hew Group

Delete a3

1.3.4 BB ADEE
ERHE T 5125 B i 4 s A o4

£ GameFace Messenger 74 2 Hir1 » % Contact > Sort Contact by ° 57 1%
A DUEIE (IE Group ZUE Online/Offline ik RENI LA/ SHEE T o

COMNTACT TOOLS

Add a Contact
Delete a Contact
Wiew Contact

¥ H| v Group

Create a Mew Gronp L
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1.3.5 BiEHE

JERTREAH AT DAGE S S S ) SIS k& A KRR (R £ 0 BERII LA 48 - Gk
NI ERAR AR

F GameFace Messenger 7 # H 1 » 215% Contact > Create a New Group °© {%
AR T SRR FE R TRIE o

1.3.6 MIBRE#E

aA TRHE T 51125 B AR IR B A A e

1F GameFace Messenger fJ - # B 1 » % Contact > Delete a Group ° #357
RIS B AR TIRAE -

14 TH
1.4.1 HR—BIEEAS
SRR T 5 B R — R A -

PEfmAERE A5 B BE — A E e BB o ST IR DL P e
[EEHH - G AR DB ASLE T /7HEEEED - ARGE Send
FOREEAIREA, -

LN /2~ Conversation: Jason

(EILETe EDNNGG WISOLSE
W
kars (Online) says:

I'm using ASUS GameFace MNow | e
Jason (Online) says:

hey, me too ﬁ

- Last message received on 2005/04/12 12:00pm
Powered by o,
by R e g ° G

GameEFACE @ byteSWARM

o
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142 BRIER

AR IR T SIS B R R %

1 DUR S — (i A BB Z R L -

2. BEEGHELE Tool > Send a File or Photo © 5 a0 (KIRE AT T EI THRIF
I

1.4.3 BREFEMF

AR IRIR T D B B2 T B

1 DI S B — (i LR AR R AR L

2. HEEARHE Tool > Send Email © 22535 (R T fE7m e THRAERTAT «
1.4.4 BRASERLCE

AR IR T 31D B AR LA S R R A 8%

1. LU S B — (i R AR R AR B

2. FEEFAELE Tool > View Message History © #2230 (KIR S AV E TR
R[] -
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2.

15 5%

1.5.1 —fi%ERE

L.

2L =2 BB .
X E I

PG AT B ) 0t < o o O

Autan

AR [E R A o

ar

ed to the Internet
d a

£ GameFace Messenger 325 /1 » E432 Tools > Option > General Setting

L D)RHEHELF
%ﬁ@%ﬁﬁw
Be °

L EWAPT2ET
g -

— B\ RO
e “Away” B
ilcL=l0par

g o

— DR EAELIRE
2SN
FRANERZHI)

a5
Beg °©

FE EIERE T /1) OK SELIEHIRUE » BUZENE Cancel AT ZNE S T
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15.2 [SHERTE
AR IRIR T 3128 BR AR B B AL AR 8

1. {f GameFace Messenger F3#H 1 » %% Tools > Option > Privacy Setting °
EEA T FoRR A& S G L o

—— DEABELR
BHRAEERT)

All Others fg%%gé}fg%

3 Tan 3l
—;féem%%ig

$E<<Block>>F

ook > | A LEIE AT
DEHjES - )
S ORI
BBLRIE
%z%%&%%
FhiE<<Allow>>
[ o | | BIGGEBAS

ERFHRE -

2. BiE FEGIE 776 OK #ELIEREIE @ BUREE Cancel #ELUZNG S
AR A F
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1.5.3 Proxy EX7E
AR IR T S5 BEAREER Proxy 2 iE #I

1. {f GameFace Messenger £ #H 1 » 2% Tools > Option > Proxy Setting °
PN N FroRe Sl ST

27E Proxy 3@
fRes -

%7€ Proxy @
RN BIBEE
B8 o
RREFEIELR
EoNEARSRIAL)

ab
Bg °

BAFRAER
FEREERH
(User name)

ERZRTS
(Password) ©

2. BGEEENE N7 OK SELIEHEGE @ BUeRHE Cancel SELLZNE S H
AR EE] R
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1.5.4 EiR
FERHE N 515 B2 B T 3% e R0

£ GameFace Messenger +3ZH /1 » B3 Tools > Option > Skin Setting ° 1%
F N AR AL e S g B o

Ik i;’acy—:.Pl:oxy-i skin |“G.amel.=‘;ce-§

Current Skin: ASUS GameFace Green

7, ==
Skin Author Version L;Eq:m %FW/E
ASUS GameFace Green AreGain Inc, 1.0 %qj%%/@\ﬁﬁg
ByteSwarm GameONE Messenger  AceGain, Inc. 1.0 @EB’E}EW °

ASS GameFace Red AceGain Inc, 1.0

. BOENIGRRE
ARE -

2. BRE FEE T 0 OK #LIERZRT » BUSEHE Cancel HELIZNE S H
AR AE| e o

20 ERBAFERTM



1.5.5 GameFace
SRR N 31 B A BN GameFace 3% 7€ 2 ©

1. {f GameFace Messenger FEH H » B% Tools > Option > GameFace
Setting  $ZE AN T A7 A & 2 i dr B -

REFRIES -

REHFELIR
BURERRIEY
Input: %E*ﬁ%@@]\
S S— o

EESWKE -
fBE I NS

ey

2. BGEEENE N7 OK SELIEHEGE @ BUeRHE Cancel SELLZNE S H
AR EE] R
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2. ZEf§ Splendid fREAR{LTIAE

21 BN
#E1 Splendid AN BT T LU M B HABITR G - 1ot » 15

BT L A TR A SR T T AU L (Contrast) ~ B350 (Mode) » 8175

PR L BT D sk, o

2.2 #{TEERE Splendid REARILINAE

HERIR LT BB AE THERE Splendid FARMLINES -

| BEEA AT A BRIG THREEE > BEEEST B WENE BT
BT o (ERTRAARE T e Rl R R o
L BAT T 6 A 2T o

Plug and Play Monitor and NVIDIA GeForce 6800 Series GPU Prop... E\@

_Color Management I & ASUS Il &4 GeForce 6800 GT
General | Adapter I Monitor [ Troubleshoot
Display

If your screen resolution makes screen items too small to view
comfortably, you can increase the DPI to compensate. To change
font sizes only, click Cancel and go to the Appearance tab.

DPI setting:

Normal size (36 dpi)

Compatibility

Some programs might not operate properly unless you restart the
computer after changing display settings.

After | change display settings:

O Restart the computer before applying the new display settings
@ Apply the new display settings without restarting

O &sk me before applying the new display settings

Some games and other programs must be run in 256-color mode.
Learn more about junning programs in 256-color mode.

22
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2. EFEOIE L ITHY ASUS KR4 B ST B8 Er R AT T FRA ASUS Splen-
did AR EH M °

Plug and Play Monitor and NVIDIA GeForce 6800 Series GPU Prop... (2 |[X]

General Adapter Monitor - tblgshoot
Color Management | & ASUS L €2 GeForce 6800 GT

[ asus osp(; ASUS Splendid

Q”e"d’d o 3 LRLBSERB -

Settipg: %ﬁ%l’\/{ s-‘a %ﬁi Ea
Enable ASUS Splendid Dynamic Contrast 128 FZ%EE Sp|end|d
Lo ] I8 -

Mode

[enriched o ‘ To enhance color. Recommend for normal %ﬁ%k\/{g ”ﬂ%-ﬁ E
S =}
L I home entertainment. Bﬂ;ﬂ%ﬂtt °

RESREER
%DJ‘EEE@?EE

ELEEE
(BEETRE
RE) -

REE

o) (oo ]
FHE Splendid REAHILINEERTNIIR

LS DkERGR
Enriched HERF R R R E -
Vivid Colors | 5t (WA A BORNELE L SEAR IS S AL V2T

Theater KB H AN E HAGE R BT BIbe B m B ATCR -

Crystal Clear | F&H1fIf55(LAGE R BIIEHHEE -

3. BNE OK AR IR E AR -

FRBNFERTM



3. ElRER AR (0SD)

31 BN

AR RN BUT IR (0SD) - A DREERIELETT 2 E R DirectX

% OpenGL ] 3D JH#IEHIRF » thn] LT AIFRES S R AE

3.2 HEFEEESANGFETIIEE (0OSD)
IR B B AT SR LB BR RS (OSD)

1.

BB (R LR GG DOREHE » il HEh 1AE BUn
Bl o (ERR AT T - FHEE B fE MR E R R R

EFE ASUS 1405 » BEE3A R0 T — g B R ) ASUS OSD 45 »
B T E TR

Plug and Play Monitor and NVIDIA GeForce 680D Series GPU Prop... [?|[X]

| General | Adapter I Monitar | Troubleshoot |

Calor Management & ASUS &3 GeForce BBO0GT |

#3515 05D | ASLIS Splendid]

A£5U5 05D
ASUS 05D provide pou the access to dynamically adjust parameters in
fullscreen D30 and OpenGL games,

fisUs

ol
Settings

Enabls ASUS 05D

annifll

ama 1.00 |

Hatkey

Ctrl+4k+0

577 Enable ASUS OSD #1Z5HE LIFARS HLIHRE -

P T] DIBEE Hotkey T THOMRAIGHE T T BER R EIA S © 1
TEFAE S » BB OSD IIRERIEMIEES Ctrl+Alt+O ©

BLE OK DIEHRE I #HET » BUREHE Apply KEHRKE © Motk - &th
Al LLEGE Cancel FEACZME 58 51 3% @ i fEH o

24
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4. EH8 GameLiveShow
41 BN

H#ERF GameLive Show AJGEATEME TN R R E DU BIUR » ][R
B HA FT % 7y Sl EIHEBe o HABAIHIAR AT LUEE Internet Explorer B1E 25 5K F
F 3% GameLiveShow FIIRFEELEEZ o AL - A thal {5 H GameReplay
DIRes ek I il B R bSO TR A o

4.2 SEEBLLREAS

4.2.1 #ITERE GameLiveShow B GameReplay
AR KR LU B ACEA T #EAE GameLiveShow :
2L ciA Y GameLiveShow [ETs °

& GameLiveShow FRAAEITIR » A1 & AR A B (F € BT (£ S ik g
[:Fl o

4.2.2 E&TFE GameLiveShow

£ GameLiveShow HIE%E B 1 » 0] IGEISEREMRATIE ~ SRR ~ i ~ £
R SH e R B BRI & R R - GE G R A
GAMELIVESHOW [E/R LIRS T 915 -

B e
B\ 55 AR
SREATRT o
BV -
HEUEEER - o]
léﬂ)%%ﬁgﬁg ° | [ enable authentication
RERPIRHA [Eai T Allow iewers to see rmy ASUS
@LBE ° araphics card information
@A HTTPETE
IR -

nEAFFAELD

3 D NG e
L pRES B
SR e IF5R -
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4.2.3 EXE GameReplay

£ GameReplay 3% T &R > nLIERIEEREMEATIE ~ SRR ~ BRIFHL
i& » B GameReplay ZA## o FHELEER /70 GAMEREPLAY [ERLIEETR T
ERpES R

RORLIBRTERE
IR
REBRERL
=,

RRLLERZER
BB -

REEBNEY
FHTRE -

ELEAME N Fy—

4.2.4 117
ek (Preview) ZEH 0] LEEEBIEHH GameReplay JIREFT RSN
1 © AHEHE PREVIEW [ERRET T 51335 o

FORDIBRTERE
I -

RRLLEEDE
TSR -

2005_03_18@17 17 41 avi
. Delete

2005_03_18 47 avi

2005_03_18@17_38_19.avi

R B0 BN
E

26
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4.2.5 £ OSD HBAEX GameReplay LIEE
AR T 910 BE(E OSD HRE GameReplay TE :
1. TEMEERA 2B - B E R EABE 2R BHRE OSD TRE °

2. ifE{¥ GameReplay Setting ° 1% %)# Enable GameReplay /7 {135
HE ©

——

o ——

- 5
ey -

- S REC_,

3. EEITHEEE BRI - (ER AL T
A e BRI TE .2 P ASUS REC &
o RREAEEITEE

ERBrFERTM 27



4.2.6 1 OSD HAREEE GameLiveShow LhgE

ST OSD ilfi#iT GameLiveShow TIHEAREH b5 v] LILEE 1E BT 255
Wt R R BRI Bk T -

FHIIE T Y5 BE OSD HIFERE GameLiveShow WAt
1. (EBRE 2R o R AR E R EAPRBERE OSD TRE

2. #H &% GameLiveShow Setting * %7 %):# Enable GameLiveShow /¢ {flff]
HIEHHE o

Al CHANGED [

WORLD

2. HEE T <End>HSEH OSD ©
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4.27 EHimFRPRE

i BB E BRI B R A B2 BL BT - H P Uik Internet Explorer 155 25 7 2L 5c 4

BT R ZWHRE -

AR T 15 BEARES € {51 Internet Explorer 2% #5

1. (X Internet Explorer %5 25
2. KIFEGE TH > $apseams®s -

3. {E MEBXRERGOEE (e - FERE
LVTH) Tt AR - HERTERE B
R [ -

4, WEEIEELEGE DY) M LR
Trusted sites fi% ©

5. 1E Trusted sites % 11 » FHEME L
ST Fii A B Im Y 1P 3k BUAE
UEATHE > BEEBNE BT ARG ST A P
ARIGIHEAIA T TR 51 K o

6. EIRETRE  FHEE BEE HRTERL
H/E 0 Bt nTENE BOR SORIGH
R R e

A Welcome to MSN.com - Microsoft Internet Explorer

File Edit View Favorites BGHS

Help

: | Mail and News »
< [ﬂ Pop-up Blocker >
Manage Add-ons...
Synchronize...

s @ http:ffww, msn.col

Trusted sites
This zone contains Web sites that you
tiust not to damage your computer or =
data.

Secuiy level for this zone

Custom
Custom settings.
- To change the settings, click Custom Level
- To use the recommended settings, click Default Level.

Trusted sites @@

‘You can add and remove Web sites from this zone. All Web sites
in this zone will use the zone's security settings.

‘Add this Wb site to the zone:
[ http:192.168.38.47:90] (a3

Web sites:
hitp:/{10.10.111.54 i
http:f/10.10.111.55

[CJRequire server verification (https:) for all sites in this zone

ERBAFERTM 29



HiE HATESOCHR Rt 6l

RROARS AR BRI A% HEE S -

FE WEE SR LUR B S A
AL ©

=

net Option:

General| Securly | Privacy | Content | Connections | Programs || Advanced|

Select aWeb content zone to specify its security settings.

Intemet  Local intranet Restiicted
sites

Trusted sites
This zone contains Web sites that you
tust not to damage your computer of
data.
Secuiity level for this zone
Custom
Custom settings.

- To change the settings, click Custom Level
- To use the recommended settings, click Default Level

S R
(Customtovet.

Security Settings )X
Settings:

ActiveX controls and plug-ins
Automatic prompting For ActiveX controls =
Disable k- |
Enable
Binary and script behaviors

Administrator approved
Disable
E

C)
[§] Download signed ActiveX controls
Disable
Enable
Prompt
)] ngn\oad unsigned ActiveX controls
K] J &

Reset custom settings

Reset to: [Low v [ Reset

v
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4.2.8 EimFAPER

TEIE % ENT Internet Explorer 1% #3122 2 MR € 1% » 18 v] DUFH A6 T i
F A% 2R GameLiveShow Rl EEELET -

A IR B8 B A A b S P R S R T

1. {E Internet Explorer 1% #x gtk 51 > i A0 T GameLiveShow A
IRF 0 ISk TG R O 4% TP i3k o

2 GameLive Show - Microsoft Intemet Explorer

Fle Edt Vew Favortes Tooks Help

Q- © HEA G Lot Soraoss @ -5 B -8

podiess | hpaj172.21.12,90

Show the et you inside.

©
Game lee Show |

200

&] pone @ intemer

. A0EERTR  GERERITE SR S P B | g R LY 5E
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5. Zfg SmartDoctor

#ff SmartDoctor R3kEHAIRE BT RIS « EREAEIRT B

o > EEAAER e H BT T LA AT RS (GPU) I

> AT 1T SRR RO IR E -

5.1 IhEE

o ERETRF LA AT RS ~ B i SRR B -

o SEEIEE R EE  RE R EE) - LR BE% R RIR BRI
SRR AR RE

o HHOTE P BB 6 B AR E A AL DR IREE T B e
HTTAEEE -

o QOREIEFOESF (GPU) BV B SRR S f sk -

. AHTFHIEEELS, (GPU) HEERRIRE -

5.2 B SmartDoctor

#Efif] SmartDoctor F—H B AR » BEAHBEXGES—R Win-
dows [FHBEIRHE B BhE T IR A BR FAIAREE » ATAKBARSZERE SmartDoctor fY

B IR LIRS > SRR G A T Akt BRl E T -

~ ASUS AX700Pro

BRI BEMIS
B
HIE) R B BRI

BRTER
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6. {FAEETE SmartDoctor
SmartDoctor $HEE T 75 81 A0SR B 8 ) 2 A 0BT -AIRIE -

6.1 EREARREE
BNV BRI IR T - LUBRBR RITEREIRIE -

‘ﬁ. - IBEYESRIRRESTIR e AGP At HF VDDQ EEA] AGP EA
B33 NHER » BRIBEEE
ARHEBRFAIENEENERER - Al FB VDDQ EREIEEHE
TRINEREELEE -

6.2 REARREREES
BhEE ERRERE R - DB RE R RIRES ( GPU)  KECHER (
RAM ) iR fﬁﬂkﬁ

@‘ EINEET ERTIE RAM DIEEREER  BIAEESBTANENE
HBE -

FRBNFERTM
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6.3 EBmARREEE
B0 A SRR » DT 0BT R E AT R -

6.4 iEB&EANECITRRIIRR
IRATLIFBEREAGE S (GPU) RIRTHEMSIRHIR » USRI T 10
HE < BEFR AT -
1. §i18) Engine L LLZRAE R A04AIEER H IR -
2. I8 Memory FHHLLLERAS BT 0TI RIFIR -

3T () B R -
4 BEEROER—STAR AT OK 8 -

Overclocking

' The dock you set exceeds factory-default value. It may make your system UNSTABLE.
Do you want to continue?

[ oK J[ Cancel ]

5. TEFRRE HHEIE S P IRFIR & BN (EREAHE T - FRLE HERE -

o EZ | E3mETRERS5 I ZRIKECIERIIREERTEE » AR
FEERSTVETSERRVER » IS G AMINMEEE IR EA T
BRI -
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6.5 EREREIEE

QUARERTTE B 2ERH SmartDoctor HIMEFERLE > FHHNE SmartDoctor
lnl:p)] gt
6.5.1 ETE

QAR B ERE » AHENE SmartDoctor 7% i€ it HY Settings 124 14§t -

#1 Smarthoctor Settings

- Setings )& Monitor | @ Fan Contiol | [ HyperDive

Monitor Settings

Moritor poling time intsrval

[ Enable overheat protection

[ Disable warning when running 30 games

[ Minimize SmartDoctor after running 30 games

I Minimize SmartDoctor at next reboat

Monitor Settings

R T A A B P

1. EEPEREREIGIRG 2 1E ] DIER € % /DIRFEIRE SmartDoctor i — K BE/R
Fi o THERAER 5 7 o B thn] ORI bed R R e e & — e Bl 5 A 1Y
RRE -

2. FEHLESHGE L) E A EENE AR G SR tH R B PEThRE

3. EREEH S EHREEFRE

FRBNFERTM
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6.5.2 Monitor
112,\\\T§llfﬁ%%*}5**’% FRJRR ~ YL B B PR O

. 1£ SmartDoctor HY3ERE ﬁ?ﬁ%ﬁp!ﬂi@ Monitor 24

#1 SmartDoctor, Settings
& Fan Contol | [£ HyperDiive

Vokage: Alarm Settings
I AGPUDDO) 150 £ 0.00% [ ycC 330 +0.00V
I FBWDDQ 2,10+ 0.00¥ [ YCORE 1.35 + 0.00Y

woltage Errar Bound: —— 09
Temperature Alarm Settings
I~ aru T

Fan Alarm Settings —
I~ Fan Speed — ORPM

EFETRT

© BLELIFARE LI R IEAERINEE : AGPVDDQ ~ VCC ~ FBVDDQ
VCORE EFE(H °

o BRSBTS AR A T ) b o

BEETRE

© BLEHEEHE LB SBRPA LR A BRI R R R TR

© HERE BRI o 0] DI BE T G E L B R R R
o
BREZERRE
B SR S AT E LA e o o P, ok 5
©E ARG AR "TTLHEJJ(%%JLLJ\;HMW%@L_

g (O E%HX?%EE—FEBU&Q@EEEIE  EBITEERERE R Default 5228
) ARELREE

2. ELEER DIERRRGE - BUTELE R SRR TFRROE DR N BE (R -
iR T I AT HG 5 R R e L

36  ERBAFERTM



6.5.3 BmEEH
R TR T 21 A5 B Al ol P 2l 3%

1. 1E SmartDoctor f3EFE 3% € 17 1 2HE Fan Control 245 o

#) smartDoctor Settings

& Seltings | @ Monito (& Fan Contial) [£ HyperDiive

& Manual Mode
Fan Power Level

" Enable SmartCaoling
Temperature Boundaries
Fastest

c

Fast
A [
Mediom  ———————_ o¢
a
SIDW‘.‘.‘.‘H...HH g e

 Auto Fan Control

2. FHEFREA LR E MBS DIRE - BRI Al B =IH © FE
52 (Manual Mode) ~ #EANAA] (SmartCooling ) Bl B il 7424 1]
( Auto Fan Control) ©
FEE - AT LU R B R B 7 RS — (R S A A AR R
PRI o
R SmartCooling : 51 #)SmartCoolingl/J6E » 15 1] LK IS A& ] 5 F
AR P 2R R Rk SRGIZRER - @M & R 121 60 CLLE
I » SmartDoctor {8 & [ BHE = BCEL a3 iR LUs A E & oo mT L
T4 BV I AR B S A R P L O B2 PR PR
B LA EE
?%’?E@ﬁﬁﬁ * SmartDoctor i< & [ By %l i LUE S i 3L
BRI ©

‘@. EMETETIEE RISEEHIE Bl Fan Control IZHRETE
IR e -

3. BE EM LIEMRT - SUTELE FEE SELUR R DRI 1 -
iR TG I T E 5 R R A
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6.5.4 HyperDrive

RAMCHE T 910 BR AC#8 B #ERH HyperDrive JIRERXJE
1. {£ SmartDoctor fEF&E% € 1 & 12112 HyperDrive 1545 -

#) SmartDoctor Settings

E1E HyperDrive JIHE

aR IR S8 B B ERH HyperDrive JIRE

1. {£ SmartDoctor fERS35% € 1 121 3% HyperDrive 15455 » Ifi 8%
Enable HyperDrive 7¢I 5EHE SRS B RAPA A TRE

2. BREEFTEEYE Z HyperDrive Rzt /e (IS EEAE I LU -

ﬁ‘ BT HyperDrive 3D mode ¥ » FSCIERIRIRMCZ 1S ASUS
Enhanced driver iZ5888 BR8N 2T, ©

HyperDrive tRI

* 3D IR ¢ 15 3D BRI - BT 3D B > ZERE
SmartDoctor & FI B % & HIRER R 3E 2 ] AEIE B e sl ESAAR - T
{ER Y 3D L% > HERE SmartDoctor {H & HERER F b GPU BIGCIEHE
FROAEE IR A EE AT AR [T TR M1 » DARE PR AARS ESE 1 o

* CPU IR - /£ CPU BEAIIRE » ZERH SmartDoctor & KIREAK
CPU HY A BUIKREAR B FEFHE RS F GPU BLEC R REA (IR o BIZR
# o HERF T CPU MY EBE AN » (HE% GPU SLaCIE AR E ERF Ik
AR B BGRHBOENE 5 BB ERH R CPU SR h RIEIR R - FIlA
DIRE BT GPU BEC R EIR IR RE 3 S B AR E 1 -

© REERS  TEARRE > FE(E SmartDoctor G RIE GPU HE (IR B 2R H)
FERRE EEEIRFAR - BRHIAER - & GPU /L& (FIR BRI »
SmartDoctor VI @F#(K GPU HUEFIRFR ; 1 GPU Ay {Fili EEE K
IR » (e B BRI T > DIERCEAFRIRRERIT -
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3. & HyperDrive #a% € BN » 0] LIBHEFH)E%E HyperDrive IRk
$E%% (Manual HyperDrive Clock Rate) RS B YA SR R R A

4. BE FERH AR GRE -

#) SmartDoctor Settings @
$ Setings | & Monior | @ FanConuol £ HyperDrive |
I Enable HyperDrivel
Settings
@
5
o
=
—_— ]
[k | conce

5. BhE ER UEMTE - BUeiE B SRR e LR R E A -
i OR HI G s LR R E R E -

FRBNFERTM
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7. E18 Video Security Online

7.1 $ITEENE Video Security Online

aA R T P B AR B #ERE Video Security Online :

AR EELE VE SR Y Bigh ThRest o W KIE AR > ASUS -> ASUS
Video Security -> ASUS Video Security UGN T & ffm i E -

B R
R

3 Lo
IRRE
B ()
B -

HISTORY

—— WL R

- ES

FEEELUETTIR
il o
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7.2 JIResR

QBRI ERE Video Security HIERE MR » FAEHEHERE Video
Security i Fi AT o "=ﬂSwm&%

7.2.1 TEEE

QAR £ 3% > FH1E Video Security BT HIEENE P 4)5E FEEE =
IE o BANT & AR A JOE B g I

® ASUS VideoSecurity Options E\

( - Main Setting ) Mair ]
-~ Email Setting o .
i Diekecting sensibility:
- Record Seting e i J Lelal
Device Low High
peveree v; [_oefouit |
Detecting interval: ¥ Default
(times/sec) 1 z 3 4
working directory: [ Ci\videosee | [ erowse ]
[ autorun detect when program run. []Enable multi-devices
Enable alarm.
[ pelay detecting for l:l Seconds
) Detect Region window Style
@ Full wirdow (& Mormal
O User defined (O Minimized a5 a tray icon

DF]M1EIEIJE£/|_.\ z §£
7R DAYE S HE SR R U 20 - AR &EE Video Secu-
rity $ 7 EEREAR R S U -
oo
T PHER BORERE AE — M I OE I B (R IR AR T I THER 2, -

— @~
Detecting sensibility: @ ‘ Default '
S0
el Low ah

. BRI TSI -
T ENREMREINNSE e -

AT ERBRER ELERMREMNRRREENR -

FRBNFERTM
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AR RAERSH
MR HLARE () (SRR o BARSTHIBRIRSE (times/sec) U

(Scan rate) A VYFEZEIE @ 1 times/sec, 2 times/sec, 3 times/sec B 4 times/

sec °
s
T TR IR HEE R AR -
/\ e ——
Detecting interval: : \;/ '
(timesfsec) 1 z 3 4

W ESEEERERNENNE  EERTESUREE -

HREXRFBLR
i APRTEE $% BCBLE TR REEE TIFE R -
AR R TER TAEERIER @ C:\VideoSec © & BRI TEERE Video
Security IFF{E & /33 —HHIERIR o ML—& RIS R A e kiR
B TIRFAIRE I H BT » SBEIRER » PR A “2005.06.
16_04.20.10" {212 Video Security /&7E June 06, 2005 f 4:20:10 AM [
R -

wiorking directory: qc:ﬁl\gideggec ) K[ Browse D

‘@ EEHE Video Security IETEH\1THT » 378 B TIFERRMUIBELIEES
BETHERAOMEEE -
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X EELMTTNEE
A AR LN T HORERAEAGE T A BRI E
- B REEGEITIR B B IESAE LI SRBAPAZERE Video Security HY
HBYTYIRE -

[ ] Awutorun detect when program run,

© B R BIENHE LA SRR ERDIRE -

Enable alarm.
- BGE S ERNRSEE HIEGHE LIRS SRR SR % E A R AEE N D)
fE

[ |0elay detecting for I:I Seconds

© BE AN XXX B BEERAE DA RS SRR (e £ T R B AT
BYIRE © FIEARELE - HIFH A\ DGR E N B R g AT
il (DIMPREfL) -

Wiz ER
EFHIES
1% option AR E IS - WEREHEIER « BEEIKERF H
EE o
Deteck Region
(%) Full window
i) User defined

R ERE RS
BHE option HPRRE AT LRI E MK o WEERENA © IEH - &
/ME - BEREAER RI=2H -
Window Stvle

=) Normal

{:} Minimized as a tray icon

) Always on kop
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7. BNE WEE HEUGATFRRCILR - B5E BOR SELUZNE LRI o B
AR B LA I -

7.2.2 &1\ (Mode)

MAREY TR RELE » A 1EHERE Video Security HUR%E $IAEHE hBHE B0
SR o BEE AN I Frn A JOR B & T

* ASUS VideoSecurity Options b_(‘

=SNG
Record Setting
Device (3) Skay in the detecting mode until users press "Stop”,
Advance

Detecting

() Leave the detecting mode whenever the number of conditions reaches

[0 ] times.

() Leave the detecting mode immediately,

Tracing
[]5tart tracing whenever a condition is detected, and
Stop tracing when users press "Stop",

Stop tracing when the target stays still For l:l seconds

1 GEERE(T — B AGEITHHERGE - BROTEHA

- PREHEIE » EEIFFET “Stop” Al ¢ E Video Security {HHIF]
FHIRDUR Er (A > RIS EEE LT “Stop” A EELL -

- EERAE IR N E E R R BORRDE Exx K« ASEH LERIERE &
% RS TIHMIE IR % » Video Security 74 715 11 Tl H
W o FETEBSANAE i A B AN SRR B % O R R BER O ©

- ZETEERAEIIRE < 3R E B IRDUAIEI » Video Security 8 {5
IEEFTEH -

Cetecting
(%) Skay in the detecting mode until users press "Stop”.
(") Leave the detecting mode whenever the number of conditions reaches

I:I times,

() Leave the detecting mode immediately.
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EEBHITV

BE B RFE AR RGN - ... /7 B EEER B AT RE AL

B B2, -

© BBEMELT “Stop” FEMEILEHRE - EEETERPLT “Stop”
RS BB L E T AR -

© EBHEE R AL x ORI L EHE - B R ORRRR L x PO
RAEE 5B LA TIEHE o AEERRAEd E Bl AR BEie DANG IR
AR B

Tracing

tart kracing whenever a condition is detected, and

Stop tracing when users press "Skop”,

Stop tracing when the target skays still For seconds

HEE W SRLIERTFROT LR o BE TOR SELUZRS S LR - 2
WRNARM S LIRSV
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7.2.3 BFEMEE

TEEF B E —HI I E SR E R R B REGE - AR E
BRETEHN LR - WAEUE %ﬂ#uxm » A IEHERE Video Security
HIEEHEEEE BB E B o BN TR RO R N

ﬁ. EEEATIRR - AR TERET #E EENHEECRTE -

# ASUS VideoSecurity Options El

Main Setting

-
Sending Email

ng Sending out an email For warning.
Device

Adwance

To: | jojo. saberola@gmail.com ]

< | bil gates@microsoft.com |

BCC: | steve.jobs@apple.com |

Subject: | Security breach

Body: | dude, someane broke into the jedi temple

[u]

Settings: Sercing Wl settings | [ Test Mail

[ER R wER T INEE
112,\\\T§'Jfﬁ%ﬂ€;’s‘<ﬁﬁﬂ‘£% HIERE -

FEERRRY F 2R E —Hich - A5 500% A DhREREIEAE - 5225 38
BRI -

® ASUS VideoSecurity Options El
( Main Setting } Main Setting
Email Setting
Detecting sersibilty: =
Record Setting (gg%)g Y Cetal,

Divice Low High
Advance

-

Detecting intervali v Default
(timesfsec) 1 & 3 4

Working directory: | ciyidensec [[ romse |
[[Jautarun detect when program run. [C]Enable multi-devices

[]Enable alarm.
[ Delay detecting For l:l Seconds

Detgctiesion Window Style
_ @ Full window @ Hormal
() User defined O Minimized as a tray icon
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2. BhnE: %ﬁ%fﬂ%ﬂﬁﬁﬁ%%%ﬂ# REEEENE B WEE T
A EEAE SR BARE A DyhE
3. W?fk%ﬁ%ﬂ3@¥ﬂﬁum £/ EIBE o LIT & HEHE
Eﬁ&mﬁ%
o W - FETECLRR IR A B B B ERAHE - & Video Secu
nw%MEﬁﬁiﬁ%% ERE > HE AB N ESE R —E BT
{548 -
o PR BIAR BT HHBEE M EETEHERN - Bt
TEBURROT i A 53— A 7 B E A (ak -
©OEE - BURIR 0 BT LR EFEHER o SR MR A — %
PRIAR BB ER - (A R BB RSN E B
AT B E RO -
o R - FER RO AG R
© R - FERIURI A G ST o

® ASUS VideoSecurity Options.

NReacnd Sairfy
i Devicel Setting
Advancel Setting To: |ch\ngjanlu@gma\\.com |
oo | |
BCC: | |
epumatt: | hella
Body: | ASUS Video Security Warning...
Settings: Sending Mail Settings I Test Mall
(4
Help
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. AHAE FRRE T ERE AR T E 2 B EREAHE R ST g

BT -

ASUS VideoSecurity - EMail Configuration

ERRE B0
BRRMEES

BV ERTaRsEE
Port Mumber: ﬁf’@ﬁgfﬁ]ﬂﬁ%@
Mail Address: | pk_lui@asus, com, by | gg;n,.—‘-.

X AE °©
Authentication Method: | AUTH LOGIN v
Username: | asushpt_lu |
Passward: | ooooooooo |
i

s
D Auto Connect to the Internet

Bind to: | Anv_1p_apORESS |

Encoding: | Western European (I50) - ‘

[15end all messages MIME encoded
[15end all messages as HTML

Message Priatity: | Mone Defined w ‘

7.2.4 IR¥%38

ATHH P & ER T T BT RH R 2
PR  EBREE B ~ R TI ~ S RIS o LUT
G IS HRE 2 BH -

- ERRAE/ AL - FETESCRRGLI ALE Internet BT T 402 ¥ F ERIFH) SMTP

BELEAE - KA L

falfl#s izl o {540 : exchange.companyname.com (/& 149.112.144.153 ©

© SR - PR Internet i PR T USRS (AR A @A ARG o TR

S 25 o

Bt FOFERE BRI o

- BT A A AR B TR ) AR B S T 5 o

- HF4%- AR F AT o

RS- AR AR DUER BRSO R P OE RIS o A I T RER

REBCF IR & 78 o
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7.25 H{EIEE (Misc)

AHH R A H TR FAR AR E TR ZBERE - 2% LU MR
B o

E BB ERs B EOT P - R A B A AR
ETF(E E"Tﬁﬁﬁ’ﬂ’] 1P Bl F{ S B (Al s SRS A5 - %iﬁ@ﬁbi’é
{THEBIIE - GR 0 EBIGR L AR Bk BAPA A D e

SR < RO L ACE BB A P (3L - FHEE

LIS 1P fi7d
MBI« 3% AR ER T EEAMRRS /7 XFHR o FERLEE H L
fé?%ffﬁﬁ%ﬁ‘t

LAMIME $GiSZERFAE R © 11308 MIME FHEGE © iahEE e
TSR BRPART A #S B MIME #RfSHIF S 2 -

LUHTML Z2FrEAR Tu%%"f LA HTML A RAERERIA. © G E
PIREHEACTH Y BRBAPA A Dhe

ﬁﬁf?ﬁ*ﬁﬁ BRE T EFAR ARG o G EHHE AR R X B
Uiie

5. BLE FERE DIRTFRE B0 HOA DUGHRE ©

6. At WRATE B LIEAE A F B E -

7. BLE FERE BELGEFRGE AR - BE IR BELURNS S AR - Bl
WRNARM S LIRSV

FRBNFERTM
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ARG E SR > FE1EFENE Video Security HIAFHE TR SREEE I -
ST AR R B s

* ASUS VideoSecurity Options El

Main Setting
Hode

Record Setting
DEvice
Advance

K

Cancel

Help

AR IR T 31D BRAGEA T B B B A

1. BREHEIHEARG R RER KA EhIhaE 5 -

2. FAROTFARHRE  FGS LU A B RS A AR A i A BB (L
PREa) -

3. BNE WEE BELUGRRTRRROT LR - 2% HOR HLURNE 8 LR -
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7.2.7 HIRRENRE

TEAHIPG & SR G EET AR B SR ORRUE - MAGEEA
PR E SRR M RROT » RIEIEE Video Security FIAHHEHENE FifeseE
R » ST B R B B AL (I

* ASUS VideoSecurity Options (X
Main Setting Devicel Setting i
i Mode
j+ Emai Setting Wideo Capture Devices
evicen Setting Devi
L ATVETEETSELING
Video Standards o g
Color Ssttings
Brightness J
Saturation N,
Contrast U
Hue )
—T— R

REMIERE

AR T I B AGR E HE E -

1 AR Fefiif T REH LR R AR E -

2. BLE BUSRHRNE T B DUEIR T & (e A (LSRR e

‘Widen Capture Devices

Devices: | y-GGear TalkiCam 1.1 v |

Wideo Standard: MTSC M
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3. FRLNE RSB HURER B E AW 2 - BRI ~ S
e

AN TR S DR AR E M -

Color Settings

Brightness @
Sakurakion - @
Conkrask - @

Hue - @

4. BRE W BELIGEFRUE R o BHE TR SELLUZNG 8 5 GRH o
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7.2.8 EREESTE

TEEEFE % E L& H HTTP  (Hyper-Text Transfer Protocol ) iﬁﬁéﬂ’[@ﬁfﬁ%ﬁé}
B EHES I o AAKGARE S SRR » FETE AL E T /o (I R e
I o falfkes

ﬁ. EERE  BUENRREESERGE -

* ASUS VideoSecurity Optio

Main Setting
“Mode

-Email Setiing
Fiecord Setting

[#]Enable HTTF sarver

vancel Setthg P 1270001 v por: 80

e e

0K

Cancel

Help

EYE HTTP {EARES

FEMIE T Y1 B AR HTTP fRIARERAI DRI ET T HHRHI 2 BERE

1. EhE HTTP ke AE5HE LGS B BARAE H HTTP {diR#RII6E

2. HEREREIRE s I A Internet S ER) (IP) Hgiik ~ JdiiE R ELE
BICEWE (UIWEBENL) - 2% 43 HHRIRE SR AHREERA o

3. B eseNila HIEOHE LGRS S RRPA (A AR sl i ThRE o

4. FERERFE > HIFHE AL P QR -

5. BIE HERE SELIGTFIEAGR T o B O SELL2Ng 88 SR T -
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7.3 1REAKIR (Video Source)

AIEH n] AR 5 ALK AR
7.3.1 {BEAAMRIERE (Video source setting)
R RIRT F1 5 BEAR R E AR

1. FHEGE Video Security 7% $IFHHE Y Video Source JEH
2. EBHIZGER A F5EE AT ISR o EERAFTRIENE G EH
B2 B TR R o

Composzite
Wideo Paralle]Digital

18 A RO

E£ TVBES RS AEN

HISTORY

2005,06,17_17.11.27 -
Delate All
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7.4 BEERAEE (Set detect region)

ARG E (F ISR Z > &f H 3ERE Video Security 12138 FRh ;%
A IR o JEEAE ST SR AR AN T o Ffr 32 B {6 iy Y

, ® EERAIER  AEREERETNRARE BECHERER &R
EEE -

Shape Properties &

Select Region Type
(2 Draw To Detect Region
() Draw Mot Detect Region

Select Shape Type
(3)Rectangle Shape () Elipse Shape

O biamond Shape O Round Shape
Left Button Ta Add Polygon point ,
while Right To End Draw Polygon.

Prampt :You can draw 10 regions at most |

Select Draw Mods
(%) add Mew Graph with the properties above
(O Clear all and Add with properties abave
() 5ave the Graph and End
(O Clear All Graph and End

=

SR T AR e I
SHE S (O B A B 1 %

S

® ASUS VideoSecurity Options E‘
(Main Setting)
Email Setting e i
et ?QE(‘V:;Q sensibility J— Default
Devies Low High

Advance

-
Detecting interval: J Default
(times/sac) 1 z 3 4
working directory! | ¢ iyideosec | [ Erowse |
[ Autorun detect when program run, [JEnable multi-devices

Enable alarm.
[Dslsy detectingfor | | Seconds

Detect Region window Style
a— N s

) Minimized as a tray icon
) Aways on top
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2. FATE Video Security F 38 L5 ZUE (A Ik DARET S F2 B AU 138
fE o

3. BT SRR (Y -

Select Region Type
@ Draw To Detect Region

O Draw Mok Detect Region

4. BRE BRI R (AR AR o

Select Shape Tyvpe
(#) Rectangle Shape (O Ellipse Shape

(Diamond Shape () Round Shape
Left EButton To Add Polvgon point ,
while Right To End Draw Palvgaon,

Prompt :You can draw 10 regions at most |

5. igREEREHENEEEA -
Select Draw Mode

(=) Add Mew Graph with the properties above

() Clear all and Add with properties above
() Save the Graph and End
() Clear all Graph and End

XTSRRI AE OK IEHRRE -

(=)
nuu
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7. FH DAYE BUE — {28 1 4 B 77 RS 2 b

B AR IR

EZ TVRS B

HISTORY

2005.06,14_03.55.14
Delete All

HEAT{EHIA W bk

BOERAAERRERS 10 BIRAEE -

| FORBIRE TR TAE
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History

MR E A I R R AR - AR A R =
TG EL o I 2 £ AP History T Z3CHkIF B -

HISTOQRY
1 BEBRIL B DA FARE AT P B Y
2005,06,14_02,15.21 = o g N B
iE9

Lelete Al
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